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A B S T R A C T

A detailed description of a semi-automated process of digitalization, visualization and quantification of rock thin
sections by applying Optical Image Analysis (OIA) is presented. The main goal of this process is to guarantee the
reproducibility of the OIA method on images acquired by a high-resolution scanner (HRS, Cannon V850 Pro)
from thin sections, emulating an optical microscope. The method consists of the following sequence of opera-
tions and functions: i) image acquisition under polarized conditions by image analysis programs (SilverFast SE
Plus 8I), ii) spatial correction of images to ensure correct spatial correlation and registration by using a
Geographic Information System software (QGIS 2.14.0-Essen), iii) pore identification and pore size and shape
parameter quantification (ImageJ 1.50i), iv) storage of the high resolution polarized images. This semi-auto-
mated process grants effective pore segmentation based on images of different cross-polarized light conditions
(90°/0°; 135°/45°) and plane-polarized light conditions (90°/-; 0°/-) of the same petrographic scene. The optical
resolution of the used images (6400 dots per inch) enables the visualization of pores with diameters ranging from
3.97 μm to 2000 μm. The proposed method was applied to and tested by the quantification of optical pores of
two sedimentary rocks before and after their exposure to supercritical CO2 (t: 970 h). Through this process, rock
pore evolution after interaction with supercritical CO2 can be correctly assessed. The applied OIA system and, in
particular, the sets of obtained high resolution polarized digital images provided a basis for the development of a
remote visualization system. This system makes it possible to virtually represent thin sections similarly to a
simple virtual microscope. The described workflow offers a fast, effective and reproducible methodology that
could complement petrographic studies.

1. Introduction and objectives

Identification and quantification of mineral phases, textures and
porosity by optical image analysis (OIA) represents an important con-
tribution to the standard petrographic characterization using optical
microscopy (Arena et al., 2014; Catalina and Castroviejo, 2017;
DeKeyser, 1999; Grove and Jerram, 2011; Martínez-Martínez et al.,
2007; Pirard et al., 1999; Russ, 1992). Another significant improvement
related to thin section analysis is the development of virtual micro-
scopes for the remote visualization of images. This is possible thanks to
the availability of high quality polarized images and software tools for
manipulating them (NASA, 2007; Tetley and Daczko, 2014). Another
condition for the proper visualization of thin sections in a virtual mi-
croscope, other than high quality images of different polarization

conditions, is the correct alignment of those images. This technology
facilitates the independent viewing of mineral images (thin sections) by
large numbers of people in diverse locations (Marcos Pascual, 2014;
NASA, 2007; Tetley and Daczko, 2014).

Rock properties can be more thoroughly understood using quanti-
tative information of the petrographic components (minerals, textural
characteristics and pore space) obtained by the application of OIA
(Asmussen et al., 2015; Higgings, 2006) than using qualitative in-
formation only. Quantitative techniques based on digital images of rock
thin sections has proved to be paramount in applied geological studies,
such as hydrocarbon reservoir characterization (e.g. Du et al., 2018; Ge
et al., 2015), aquifer modelling (e.g. Zambrano et al., 2018), or studies
seeking the potential CO2 reservoirs (e.g. Berrezueta and Kovacs, 2017;
Lima Neto et al., 2014; Luquot et al., 2016).
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The development of optical systems led to a breakthrough in the
manufacture of digital cameras (both photo and video) and high re-
solution scanners (HRS). The use of digital cameras and HRS in the
acquisition of rock images has been widely used in processes based on
OIA (e.g. Enrique, 2012; Fueten, 1997; Starkey and Samantaray, 1993;
Tarquini and Favalli, 2010). The diverse OIA applications developed to
identify petrographic components in two dimensional (2D) images ob-
tained either by optical microscopy (OpM) (e.g. Berrezueta et al., 2015;
Borazjani et al., 2016; Fabbri, 1984; Fueten, 1997; Ghiasi-Freez et al.,
2009; Sardini et al., 1999; Starkey and Samantaray, 1993; Thompson
et al., 2001) or by scanning electron microscopy (SEM) (e.g. Anselmetti
et al., 1998; Cipolloni et al., 2014; Arena et al., 2014; Haines et al.,
2015) made it possible to greatly improve the performance of the
technique offering thus, reproducible and reliable measurements.

According to Anselmetti et al. (1998) and Ehrlich et al. (1984),
porosity is, in general, a powerful parameter in rock characterization
and its quantification provides valuable insight into the petrography
and the physical properties of the rock. Pore space identification and
quantification in thin sections by means of OIA is a relatively simple
task compared to the study of some other petrographic components
(e.g. that of anisotropic minerals with characteristics that vary in ac-
cordance with the polarization conditions) (Fueten and Mason, 2001).
The use of images of different polarization conditions, as suggested by
Fueten (1997) and Thompson et al. (2001), simplifies the identification
of mineral phases and, at the same time, offers an optimal and precise
method for the identification of the pore space (Berrezueta et al., 2015;
Tarquini and Favalli, 2010). Nevertheless, the application of OIA on
different images of a petrographic scene requires the correct spatial
correlation and registration of the images. According to Tarquini and
Favalli (2010), this condition can be achieved by using a proper sample
support stage that guarantees the correct alignment during the digita-
lization of the thin sections. Additionally, corrective steps based on
georeferencing are necessary in order to rectify occasional misalign-
ments. Similarly, Berrezueta and Domínguez-Cuesta (2016) addressed
the correction of mineral images applying Geographic Information
System (GIS) software, in particular, using georeferencing modules (e.g.
QGIS, ArcGIS). Previous works presented the application of GIS tools to
detect grain boundaries in thin sections (Fernández et al., 2012; Li
et al., 2008; DeVasto et al., 2012) contributing to quantifying para-
meters such as shape, orientation and spatial distribution of mineral
grains. Furthermore, DeVasto et al. (2012) and Li et al. (2008) included
spatial information in the images using GIS, making it possible to relate
the parameters measured in the image with real spatial locations at rock

massive scale and to conduct detailed spatial analyses. According to
Berrezueta et al. (2015), an easy and fast segmentation of the porous
system is possible by regions (pixel-based approach), applying the
“thresholding” segmentation method (based on threshold values to turn
a raw image into a binary one, the pixels being partitioned depending
on their intensity value).

In this study, the general procedure of digital image processing
(González and Woods, 1992) was applied on thin section images ob-
tained by an HRS, introducing some additional steps for the specific
subject of mineral quantification (Berrezueta and Domínguez-Cuesta,
2016; Berrezueta et al., 2017a; DeKeyser, 1999; Pirard et al., 1999;
Tarquini and Favalli, 2010). Our aims are i) to describe the procedure
of emulating a polarizing microscope by means of an HRS adapted to
thin sections study; ii) to provide a detailed protocol for the application
of OIA techniques to quantify pore space properties in thin sections; iii)
to provide a protocol for the visualization and storage of petrographic
images in digital format; and iv) to demonstrate the potential of the
proposed system through a case study.

2. Methodology

The sequence of the applied OIA technique is as follows:

i) Mineralogical and petrographic characterization of thin sections by
means of qualitative techniques (OpM and SEM observation). The
pores were already identified at this stage, in order to help the
following OIA quantification process (Fig. 1a).

ii) Set-up and calibration of the OIA equipment (HRS, polarizers,
software): color calibration, gain, geometrical calibration (Fig. 1a).

iii) Automation of the image acquisition process on thin sections se-
curing the reproducibility under optimal polarization conditions
(Fig. 1 a-b).

iv) Georeferencing sets of images belonging to the same thin section in
order to ensure their correct registration (Fig. 1a).

v) Identification of porosity by the application of segmentation ranges
to each image.

vi) Quantification of porosity providing pore size and pore shape
parameters (area, diameter, perimeter, roundness, and aspect)
(Fig. 1a).

vii) Storage of the corrected set of images for their visualization simi-
larly to an optical microscope.

Fig. 1. a) Schematic flowchart of the sequence of pore characterization by OIA-HRS (Modified from González and Woods, 1992; Berrezueta et al., 2017a, b) thin
section with polarizers ready for digitalization by means of HRS.
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2.1. Techniques

To carry out the mineralogical and petrographic study that formed
the basis of the quantification process, an OpM (Leica DM 6000 po-
larization microscope) and a SEM (JEOL 6100 SEM, using W-Filament,
acceleration voltage of 20 kV and Inca Energy-200 software) were used.
All the experimental runs and studies were performed at the Geological
Survey of Spain (Oviedo Unit) and the University of Oviedo (Geology
Department).

The HRS that secured the polarization conditions during the image
acquisition was an Epson Perfection V850 Pro controlled by a com-
mercial image analysis software (SilverFast SE Plus 8). This device has a
resolution of 6400 dots per inch (DPI), which means a real optical re-
solution of ≈2520 pixels/cm. This scanner uses an Optical Sensor
Matrix -charge-coupled device (CCD)- with Micro Lens and High Pass
Optics for image digitalization.

The image analysis software managed the digitalization (storing the
image in a file) and the conditions of the acquisition (resolution, gain,
focus, file format, image compression, etc.). The four polarizing con-
ditions that were used for the digitalization of the thin sections, named
1, 2, 3 and 4, respectively, (crossed polarizers: 90°/0°, 135°/45° and
parallel polarizers: 90°/-, 0°/-) (Fig. 2a and b) were obtained by the
application of polarizing filters (ST-38-40 Screen Tech). The polarizers
were placed under and on top of the sample to achieve crossed-polar-
ized conditions and only on top of the sample to achieve plane-polar-
ized conditions. The set of scanned images (four of them for each pet-
rographic scene) was stored in the Red (R), Green (G) and Blue (B) color
system. For each RGB band, 8 bits were used to express color depth (i.e.
gray level between 0 and 255). For the spatial correction and the
generation of corrected images, a free GIS software (QGIS 2.14.0-Essen)
was used. The image analysis (segmentation, classification and quan-
tification) of the pore system of a set of corrected digital images
(Fig. 2c) was carried out by using an open source image processing
system called ImageJ 1.50i. All computer programs (SilverFast, ImageJ,
QGIS) were run on an IMac I5 with Mountain MacOS X 10.8.

In general, errors during quantification by OIA techniques are si-
milar to those described by Chayes and Faibairn (1951), Demirmen
(1971) and Grove and Jerram (2011): (i) using systematic observations
for areal analysis (counting error); (ii) variability introduced by the user

(operator error); or iii) using 2D sections to estimate vol. % (3D) in
hand samples (specimen error). In our study, counting errors on thin
sections were not considered because the whole mineral area was stu-
died. According to Grove and Jerram (2011), under similar conditions
of analysis by OIA, counted error would be 0.1%. Likewise, specimen
error was not assessed because all the quantified parameters were two
dimensional. However, specimen variability (Area in 2D) at block
sample scale (270 cm3) was calculated on the studied thin sections due
to heterogeneity of material. This specimen variability was calculated
on each block sample by studying 5 thin sections for each. The operator
errors (e.g. georeferencing process) were calculated by involving five
different operators in the measurements on each thin section. Although
the study was limited to pore space measurements on the thin section
scale, 5 thin sections were measured for each sample (before and after
their exposure to SC CO2) in order to define the mean values and their
variation (standard deviation) derived from the characteristics of the
rock. The aim of this approach was to provide preliminary information
about the variability of the porosity in the studied rock types. In this
study, we did not extrapolate values obtained from thin sections to
regional scale.

2.2. OIA-HRS process

2.2.1. Updating OIA tools and image acquisition
Thin sections and polarizing filters covering them (both

4.5 cm×2.8 cm) were placed into a sample support suitable for the
HRS (Fig. 1b). This support guaranteed that the samples were close to
the same position during measurements under different polarizing
conditions and during polarizer replacements. The configuration of il-
lumination properties and thin section optical resolution remained
fixed during the digitalization process in order to ensure measurement
reproducibility. Thus, with crossed polarizers, gain (1), exposition
(100ms), and tolerance (1) values were used; while, for one polarizer,
these values were set to (1), (50ms) and (1), respectively. One color
image (Fig. 3) obtained by digitalizing a thin section by HRS (under
polarized conditions) had a size of approximately 150MB. The time
necessary to scan a set of four images was 15min, in average. In-
structions for the acquisition process are illustrated in Fig. 4, in a
general manner, and with more detail in Annex 1. Due to the scanning

Fig. 2. a) Setting of crossed polarizers in HRS, b) mineral image under cross polarized light acquired in two polarization conditions by HRS, c) digital image of an
outlined pore. Modified from Berrezueta et al. (2015).
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resolution of the scanner (real optical resolution of ≈2520 pixels/cm),
the minimum pore size that could be represented in the image was
limited to 3.97 μm. The storage of a pixel as a pore occurred if the same
pixel (exactly same x and y location) was considered as pore. The digital
representation of pores with a size smaller (< 50%) than the minimum
detection in the digitalization were not detected or represented during
acquisition process.

2.2.2. Spatial correction (georeferencing)
Extracting quantitative information from various images of one

petrographic scene (i.e. a thin section) is only possible if the alignment
(x and y coordinates) of different mineralogical components (minerals
and pores) is certainly the same in the different images (Fig. 5). The
process that secures this condition is analogous to that of satellite image
correction (Berrezueta et al., 2017a) and it is based on the GIS QGIS
software. Georeferencing guaranteed that the samples were exactly in
the same position during measurements done under different polarizing
conditions and during polarizer replacements. In particular, the Geor-
eferencer and the Clipper tools were used. With the aid of the first one,
coordinates were assigned to the mineral images, while the second one
was used to crop the referenced images to the same size. The whole
process consisted of three general steps: i) a first image was georefer-
enced by assigning coordinates to three of its corners (Fig. 5a); ii) the
rest of the images were referenced by using common points with the
first one (Fig. 5b); iii) finally, an area that was common in the corrected
images was selected and cropped, and the information was stored in
new files (Fig. 5c). The general procedure of the described pre-pro-
cessing stage (i.e. spatial correction) is presented in Fig. 4b, and it is
explained in detail in Annex 2. This stage took approximately 15min to
complete.

2.2.3. Image segmentation and feature extraction
The segmentation process results in the separation of the pore space

from the mineral phases of a thin section. Gray level values of pore
areas can be calculated by using supervised training steps. The seg-
mentation values defined as ranges for the RGB bands were: i) bands R
(0–60), G (0–55) and B (0–65) for crossed-polarized images; and ii)
bands R (185–255), G (190–255) and B (160–255) for parallel polarized
images. These ranges were determined by the application of sampling
windows of 10×10 pixels over areas of securely identified pores on the
images. The process was repeated for each new sample. The general
procedure of pore segmentation using ImageJ software is presented in
Fig. 6a, while Annex 3 describes the specific procedure applied by the
here employed software version. As a result of the intersection of partial
segmentations obtained by the ImageJ software, the treated area was

finally segmented and classified as a pore (Fig. 7).
The classification of a pixel as a pore occurred if the same pixel

(exact same x and y location) was considered a pore in all parcial
images (GL-ranges within prescribed limits), and the final segmented
image resulting from the intersection of partial images. With this pro-
cess, we secure that pores equal to or greater than 3.97 μm were re-
presented and measured in the images. After their identification by
means of generation of binary images (1 for pore and 0 for other
phases), the pores can be selected and different parameters of their size
and shape can be measured by using the analysis and measurement
functions of the software (Annex 3). The principal pore size parameters
considered in this study were the area (A), diameter (D), and perimeter
(P). Diameter was measured as the diameter of a circle of equivalent
area. The principle shape parameters were roundness [1] and aspect
[2]. Results of the measurements were saved in .xls files (Microsoft®

Excel® format). It took approximately 5min to segment the pores of four
images and measure the five parameters.

=Ro π A
P

4
2 [1]

=As
Major Axis
Minor Axis [2]

2.2.4. Storage of images and virtual microscopy
Obtaining digital images of entire thin sections under different po-

larizing conditions (e.g. 90°/0°; 112.5°/22.5°, 135°/45°, 157.5°/67.5°
for crossed nicols and 90°/-; 45°/-; 0°/- for parallel nicols) does not only
allow the quantification of mineralogical parameters (e.g. porosity
using 90°/0°, 135°/45°, 90°/-; 0°/-), but it also makes it possible to use
the digital information in future petrographic studies. For this purpose a
virtual microscope was developed, by which the images can be stored
and visualized in a computer. The operation of the virtual microscope is
based on a video (virtual stack in ImageJ) generated from all the images
of a thin section (Fig. 6b). The tool was developed with the Use Virtual
Stack option of the ImageJ software applying the following steps (see
also Annex 4): a) storing all the images belonging to the same sample in
a specific folder; b) renaming each image with a filename that contains
a chronologic order (e.g. 01 to 07) of the polarization conditions (e.g.
90°/0° to 0°/-); c) importing the image sequence into imageJ; d) ex-
ecuting the animation (video); and e) saving it in a TIF and an AVI file.
The video can be operated by keyboard functions (i.e. start animation
by pressing [enter], stop animation by pressing [esc], move backwards
and forwards by [< ] and [> ] keys and also zoom of information by
[+] and [-]) or using the ActionBar plugin (Jerome, 2008). The vi-
sualization of different images of a same petrographic scene in a video
emulates the operation of an optical microscope, since the images re-
present the changing optical conditions of the mineral phases. How-
ever, while under a microscope the optical conditions change due to the
rotation of the thin section, here, the position of the thin section is fixed
and the polarizer filters are rotated. Another difference lies in the field
of visualization area, which is the total sample surface in the case of the
digitalized images with the option of zooming in for details thanks to
the high digital resolution of the original image.

3. Procedure application in a case study

3.1. Materials

The described procedure has been applied to a study of rocks that
can be potentially used for CO2 geological storage. Pore space proper-
ties were compared in samples before and after supercritical (SC) CO2

exposure in an autoclave. The samples were Jurassic carbonates from
the Vasco-Cantabrian basin (Spain). According to García-Lobón et al.
(2010), this basin offers ideal conditions for CO2 storage due to the
presence of adequate geological structures, reservoirs and caprocks.

Fig. 3. Example of a scanned thin section (.tiff, 150MB, 24 bits, RGB color
system, 6400 DPI). (For interpretation of the references to color in this figure
legend, the reader is referred to the Web version of this article.)
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Fig. 4. Schematic workflow: a) acquisition and digitalization of petrographic images using an HRS (Epson V850 Pro) by an image processing software (Silverfast SE
Plus 8); b) referencing image set (i.e. a set of images of the same petrographic scene under different polarizing conditions) by means of GIS georeferencing tools (e.g.
QGIS 2.14.0-Essen). Polarization conditions 1–4, respectively: 90°/0°, 135°/45° (crossed polarizers) and 90°/-, 0°/- (parallel polarizer).
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The selected rocks belong to the potential reservoir formations, con-
cretely, they are vuggy carbonates (”Carniolas”) of the Puerto de Pa-
lombera formation (Hettangian) and oolitic limestones of the Villa-
nueva de Puerta formation (Sinemurian). The vuggy carbonate is a
heterogeneous, recrystallized carbonate breccia (calcite and dolomite).
Its partial recrystallization resulted in a matrix of highly varying grain
size from micrite to crystals up to 200 μm. The angular-subangular
clasts are composed of sparite and could be intra-, extra- or bioclasts.
This rock shows an open porosity of 4.25%, a connectivity of 3.2 and a
permeability-water of 0.752 mD (Mateos-Redondo, 2013). In the oolitic
limestone, most of the components (bioclasts, ooids, pellets and matrix)
are of calcite composition with scarce presence of dolomite. This rock
shows an open porosity of 0.88%, a connectivity of 3.5 and a perme-
ability-gas of 0.002 mD (Mateos-Redondo, 2013).

After field sampling, the material was prepared for SC CO2 exposure
(Fig. 8a) and for petrographic characterization by means of OpM and
SEM (Fig. 8b). A previous study of the vuggy carbonates (Berrezueta
et al., 2017b) applying OIA-HRS (with scanned images of 4000 DPI)
demonstrated changes in the pore space configuration of the sample
surfaces due to rock-CO2 interactions (Fig. 8b).

In this experiment, the vuggy carbonates (135 cm3) were exposed to
brine rich CO2 (600 cm3 of brine and 1265 cm3 of CO2), while the oo-
litic limestones (135 cm3) were exposed to dry CO2 (1865 cm3 of CO2).
The pressure (P), temperature (T) and exposure time (t) parameters
(P≈ 7.5MPa; T≈ 35 °C, and t= 970 h, respectively) were selected to
simulate the conditions in the vicinity of a theoretical injection well
(André et al., 2007). In both cases, it is considered that all the open
pores in the evaluated samples were exposed to SC CO2. The thin sec-
tions (four before and four after the experiment) were prepared from
areas of the external surface of adjacent carbonate blocks (Fig. 8).

3.2. Pore space quantification

The previous quantitative petrographic study by OpM and SEM
(Berrezueta et al., 2017b) demonstrated variations in the pore system of
the vuggy carbonates after their exposure to SC CO2 rich brine. In
particular, dissolution textures could be observed including (i) the ap-
parition of secondary pores on the surface of calcite minerals and (ii) a
relatively rough surface after CO2-brine-rock interaction.

Quantitatively, porosity increased by 7.77%; roundness decreased by
2.40%, and aspect increased by 2.26%. On the other hand, no altera-
tions were observed in the optical properties of the rock forming mi-
nerals on the oolitic limestone after dry SC CO2 exposure.

Before the quantification and interpretation of the mineralogical
parameters by OIA, the variability in the measurements was estimated
by using, both the operator and specimen variabilities. The operator
variability (Table 1) for the OIA process was tested by 5 different op-
erators (named Operator 1, 2, 3, 4 and 5) and by using 4 test samples
(C1_1, C1_CO2_3, C2_3 and C2_CO2_1). The total operator variability
(operator error) selected was 1.25 (the maximum variability calcu-
lated). Furthermore, porosity measurements were made on non-geor-
eferenced image sets. For example, samples C1_1, C1_2, C2_1 and C2_2
show variations of area: 2 to 1 (50% variation between georeferenced
images and non-georeferenced images). This variation indicated that
the support suitable for HRS did not guarantee the exact same position
of the images.

The specimen variability for the samples (two before SC CO2 and
two after SC CO2) studied by OIA was tested through 5 different thin
sections (named Samples 1, 2, 3, 4 and 5) of each sample. The specimen
variability (specimen error) is shown in Table 2.

In the present study, the comparative OIA measurements of “before”
and “after” samples of the vuggy carbonates and limestones proved that
significant changes took place in their porous system. On the thin
section scale, variations (Δ: after-before CO2) of both pore size (porosity
in %) and pore shape (Ro and As) parameters were found and quanti-
fied (Fig. 9 and Table 3). Optical porosity increased (0.32% for vuggy
carbonates and 0.09% for oolitic limestones); roughness decreased
(2.40% for vuggy carbonates and 1.13% for oolitic limestones) and pore
aspect increased (2.26% for vuggy carbonates and 0.92% for oolitic
limestones) after the samples were left to interact with CO2 (Table 3).

The applied OIA method also provided information about the por-
osity variation due to sample heterogeneity by comparing different thin
sections of the same rock sample (Table 2 and Variation1 (%), in
Table 3). Additionally, the variation introduced by the operator (“op-
erator error”) was determined, which turned out to be of 1.25%
(Table 1 and Variation2 (%), in Table 3).

The comparison of the vuggy carbonate samples before and after
their exposure to SC CO2 revealed an 0.34% absolute increase in

Fig. 5. Referencing mineral images with the use of GIS tools (Berrezueta and Domínguez-Cuesta, 2016; Berrezueta et al., 2017a; Tarquini and Favalli, 2010): (a)
image acquisition under polarized light using HRS (two images under cross polarized light and two under parallel polarized light); (b) image georeferencing; (c)
selection of areas of interest on a georeferenced image set.
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Fig. 6. Schematic general workflow for a) identification and quantification of pores by an OIA program (ImageJ 1.50i) and b) visualization of different images with a
virtual microscope (ImageJ 1.50i).
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porosity (that is 8.15%, in relative terms) and, with regard to pore
shape, a mean decrease of Ro of 2.24% and a mean increase of As of
1.94%. The comparison of the limestones before and after their ex-
posure to SC CO2 revealed a 0.09% absolute increase in porosity (that is
5.26%, in relative terms) and, with regard to pore shape, a mean de-
crease of Ro of 1.13% and a mean increase of As of 0.92%.

3.3. Digital microscopic representation

The digital visualization by ImageJ is presented here through the
example of a sandstone sample (Fig. 10). The digital representation of a
thin section of 2.5 cm×1.5 cm through seven images (90°/0°; 112.5°/
22.5°; 135°/45°; 157.5°/67.5° for crossed nicols and 90°/-; 45°/-; 0°/-
for parallel nicols) occupies approximately 1 GB. The digital files must
be properly stored and their order precisely maintained for the correct
visualization. Further examples of digital microscopic representation
are available in Annex 5.

4. Discussion

4.1. Applicability of method

The process for thin section visualization and pore space quantifi-
cation presented here was based on the works of DeKeyser (1999),

Sardini et al. (1999) and Tarquini and Favalli (2010). These authors
quantified mineralogical parameters in thin section images acquired
under polarized conditions by HRS. There exist, however, some dif-
ferences between the aforementioned publications and the approach
presented here: i) The use of an Epson 850 Pro scanner with an optical
resolution of 6400 DPI allowed us to identify and measure objects with
sizes of 3.97 μm. This value is significantly higher than optical resolu-
tions obtained in previous studies, such as Sardini et al. (1999) (0.06
mm/pixel, 400 DPI, Canon CLC 300), DeKeyser (1999) (9.4 μm/pixel,
2700 DPI, Nikkon LS-2000), Tarquini and Favalli (2010) (9.4 μm/pixel,

Fig. 7. Image sequence of the same petrographic scene under the four different polarizing conditions used for pore segmentation: a) sample (6mm2) of vuggy
carbonate and b) sample (6mm2) of oolitic limestone.

Fig. 8. Schematic representation of the sample preparation sequence (Berrezueta et al., 2017a, 2017b): a) sample blocks (B1 and B2) and b) thin sections of the
external surfaces (A1 and A2) of the blocks.

Table 1
Operator variability (Operator error).

Operator Sample/Area (%)

C1_1 C1_CO2_3 C2_3 C2_CO2_1

1 4.08 4.52 1.67 1.82
2 4.28 4.54 1.73 1.77
3 4.19 4.44 1.71 1.79
4 4.14 4.57 1.69 1.81
5 4.16 4.43 1.73 1.80
Average Area 4.16 4.49 1.72 1.80
Operator Variability % 1.25 1.16 1.23 1.07

1.25
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2700 DPI, Nikon Coolscan II) and Berrezueta et al. (2017a,b) (6.33 μm/
pixel, 4000 DPI, CanonScan FS 4000 US). This increase in optical re-
solution is due to the improvements of the used scanner compared to
earlier devices. ii) The correct registration of the components of an
image set was achieved by georeferencing all of the images by means of
GIS. This system has proved to be more precise than processes without
image georeferentiation. The registration of images has proved to re-
duce the variability of measurements (e.g. pore area) from 50% to
1.25% in our tests. Unlike the proposal by Tarquini and Favalli (2010)
regarding the use of methods based mainly on a mechanical device with
only occasional georeferencing, the systematic use of georeferencing
would guarantee a more accurate process. iii) The employed polarizing
conditions (90°/0°; 135°/45°; 90°/-; 0°/-) and segmentation ranges (R
(0–60), G (0–55), B (0–65) and R (185–255), G (190–255), B (160–255)
for crossed and for parallel nicols, respectively) were selected taking
into account the results of previous studies (Berrezueta et al., 2015,
2017a). Their use allowed us to accurately identify pores in thin sec-
tions. iv) The study was completed applying only free and open-source
software (ImageJ and QGIS) instead of previously used commercial ones
(DeVasto et al., 2012; Tarquini and Favalli, 2010). This reduces the
expenses and also makes it possible to use and reproduce the applica-
tions described here by other researchers. The proposed protocols can
also be easily adapted to other GIS and IA software.

In the presented case study, the real optical resolution of the scanner
as defined by the manufacturer (6400 DPI) was used as a reference
value, and, therefore, 3.97 μm was considered as the minimum de-
tectable pore size. Nevertheless, the users have the liberty to establish
other (larger) minimum pore size values that better fit the objectives of
their study (e.g. defining the minimum pore size to be considered as 4
pixels (approx. 15.76 μm2 or of a diameter of approx. 6.32 μm).

Furthermore, the described image acquisition procedure can be
extrapolated to any commercial transmitted light scanner in-
dependently of its optical resolution, keeping in mind that the mea-
surement range and the image quality are conditioned by the optical
resolution.

One of the advantages of OIA studies on thin sections digitalized by
HRS – such as the method described here – is the possibility of directly
representing the complete surface of a thin section in one single image,
which is not possible when using images obtained by CCD cameras
coupled to optical microscopes (e.g. Borazjani et al., 2016; Fueten,
1997; Heilbroner, R., 2000). Furthermore, mobile polarizer filters were
employed over the thin sections (after Fueten, 1997) in order to obtain
images of their entire surface by HRS (DeVasto et al., 2012; Li et al.,
2008; Sardini et al., 1999; Tarquini and Favalli, 2010), allowing thus
the visualization and identification of mineralogical components emu-
lating an OpM. It takes four times longer to carry out an OIA study of
the entire surface of a thin section using low resolution (e.g. 2x) images
obtained by an OpM than using polarized images digitalized by an HRS.
From the economic point of view, the cost of an OIA-HRS device
compared to an OIA-OpM is about 1/10.

It is possible to introduce new polarizing conditions in the image
acquisition phase of the described procedure (e.g. 90°/0°; 112.5°/22.5°,
135°/45°, 157.5°/67.5°, 90°/-; 45°/-; 0°/-). Increasing the number of
polarizing conditions has principally been applied for mineral phase
identification (Fueten, 1997) on images respresenting entire thin sec-
tions (DeVasto et al., 2012; Li et al., 2008; Sardini et al., 1999; Tarquini
and Favalli, 2010). The same approach was used here i) to store

Table 2
Specimen variability (Specimen error) at block sample scale (270 cm3).

Samples Area (%) Specimen
Variability
%1 2 3 4 5 Average

Area

C1 4.16 4.45 4.27 4.07 3.90 4.17 3.65
C1_CO2 4.56 4.37 4.49 4.92 4.25 4.51 3.82
C2 1.68 1.83 1.72 1.42 1.92 1.71 7.60
C2_CO2 1.80 1.94 1.82 1.46 2.01 1.80 7.80

Fig. 9. Comparison of mineral images of a) untreated vuggy carbonates and vuggy carbonates after SC CO2 exposure, and b) untreated oolitic limestone and oolitic
limestone after SC CO2 exposure.
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polarized images of entire thin sections registering mineralogical
characteristics with high quality, and ii) to develop a virtual petro-
graphic microscope (Fig. 10). Virtual microscopy contributes to data-
sharing and remote access, data-management and annotation and var-
ious forms of data-mining (Mikula et al., 2007). It allows both the vi-
sualization of global, textural characteristics using images of entire thin
sections, as in this study, and more detailed mineralogical observations
using images of OpM (e.g. 2x, 10x, 20x) acquired by digital cameras.
Nevertheless, a serious limitation in the development of virtual mi-
croscopes is posed by the required data size, which often calls for a
compromise on quality (image resolution).

4.2. Results, discussion and limitation of the proposed method

The measurements showed up the alterations that took place in the
pore system of the vuggy carbonate samples due to rock + CO2+brine
interactions and which were previously observed by OpM and SEM
(Berrezueta et al., 2017b). The results harmonize with chemical and
mineralogical processes observed by other authors under similar con-
ditions (André et al., 2007; Kaszuba et al., 2003; Luquot and Gouze,

2009); however, the numerical values (8.15% of porosity change) could
be affected by sample variation (3.82% of the porosity) and operator
error (1.25%). The comparison of vuggy carbonate samples before and
after their exposure to SC CO2 (Table 3) agrees with the results obtained
in a previous study (Berrezueta et al., 2017b), in which 0,32% absolute
porosity increase (7.77% in relative terms), 2.40% decrease of Ro and
2.26% increase of As were measured using an OIA-HRS system with a
resolution of 4.97 μm/pixel. The difference in the optical resolution of
the employed devices (Epson 850 Pro versus Cannon FS 4000 Us) is the
principal cause of the deviation in the obtained results since the scanner
of the present study (Epson 850 Pro) has a resolution that is 62% higher
(Haines et al., 2015; Pirard et al., 1999). Nevertheless, it must be
pointed out that OIA parameters obtained at different scales are not
directly comparable (Berrezueta and Kovacs, 2017; Pirard, 2004). The
results must be interpreted within the context of the study and ex-
clusively at the scale applied for the image acquisition.

Based on the literature, the carbonate rocks exposed to dry SC CO2

(970 h) were not expected to undergo mineralogical or geochemical
changes (Berrezueta et al., 2017a,b; Luquot and Gouze, 2009). How-
ever, the measurements indicate small variations between the samples

Table 3
Mean values of Total porosity, Roundness (Ro) and Aspect ratio (As) of carbonate thin sections (before and after SC CO2 injection) measured by OIA-HRS (6400 DPI).
Variation 1 in %: standard deviation/mean of total porosity in 5 samples. Variation 2 in %: standard deviation/mean of total porosity in a same sample measured by 5
different operators. *: Relative variation. Δ: Variation.

Thin sections (number) Total porosity % Variation1
% see Table 2

Variation2
% see Table 1

Porosity
Change
%

Ro Δ Ro
%

As Δ As %

C1 (5) 4.17 3.65 1.25 0.34
8.15*

0.630 −2.24 2.212 1.94
C1_CO2 (5) 4.51 3.82 0.615 2.255
C2 (5) 1.71 7.60 0.09

5.26*
0.705 −1.13 2.046 0.92

C2_CO2 (5) 1.80 7.80 0.697 2.065

Fig. 10. Example showing the aspect of high resolution mineral images obtained under different polarizing conditions by ImageJ. For more detail and further
examples, see Annex 5.
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before and after the experiment (Table 3). These changes were not
possible to detect by microscopic observations (OpM and SEM), and
they might be due to sample variation and operator error
(7.8% + 1.25%) and not due to rock-SC CO2 interaction. Although the
porosity parameters calculated on the samples studied by OIA techni-
ques are related to 2D scale, these data provide important information
to planning more detailed studies (e.g. 3D modelling).

The success of the method depends on i) properly defining of the
image acquisition conditions (eg. resolution of image acquisition), ii)
the georeferencing process and iii) the establishment of mineralogical
criteria to define the ranges of pore segmentation applicable to the
acquired images. The thin section quality is also an important factor
that affects the classification process of mineral phases. In order to
reduce the influence of the preparation of the samples on the mea-
surements by means of OIA, the same laboratory, the same preparation
system and a quality control of the samples should be applied.

According to Pirard et al. (1999) and Berrezueta et al. (2015), the
application of OIA requires a rigorous sample preparation protocol, up-
to-date OIA tools, and a careful process of image acquisition, segmen-
tation and classification. These altogether will warrant the reproduci-
bility of results.

This explained method could be more efficient by carrying out some
improvements as, for example, using a faster and better resolution
scanner to reduce the time needed to acquire images and improve their
quality. Nevertheless, this semi-automated procedure of digitalization
and study of rock thin section has allowed to simplify the study of thin
sections.

The technique of presented segmentation (pixel-based classifica-
tion) was selected due to the easiness to be applied by any user. The
limitation (pores misrepresented) of the technique of segmentation
(pixel-based approach) used in this work can be solved with the use of
object-oriented approach techniques. This method offers a good solu-
tion allowing that pixels in close proximity and having similar spectral
characteristics are grouped together into a segment. Also segments
exhibiting certain shapes, spectral, and spatial characteristics could be
grouped into objects. Nowadays some image processing tools are based
on methods of pattern recognition and artificial intelligence. The ac-
curacy of the automatic image segmentation methods has been severely

compromised by the presence of shared edges of grains, despite the
large number of distinct strategies like (a) seed region growing
(Choudhury et al., 2006), (b) Level Sets (Lu et al., 2009), partial dif-
ferential equations (Lu and Ning, 2010), cellular automata (Gorsevski
et al., 2012) and image foresting transform (Mingireanov Filho et al.,
2013). An adequate choice of the segmentation process is essential to
guarantee the correct interpretation of the measures.

5. Conclusions

The application of OIA to evaluate pore space properties of carbo-
nate rocks (thin sections) represents an important advance compared to
the traditional petrographic characterization (Figs. 5 and 7). The digi-
talization of entire thin sections under different polarizing conditions
(90°/0°; 135°/45°; 90°/-; 0°/-) with an optimal optical resolution (3.97
μm/pixel) makes it possible to measure petrographic components (i.e.
porosity) and their properties of size and shape. Moreover, the appli-
cation of the proposed procedure is highly facilitated by the use of open
source software (QGIS and Image J) and by the detailed description of
the protocol presented here. A significant improvement of the proces-
sing and analysis of microscopic images derives from the application of
referencing tools offered by GIS software. The possibility of visualizing
a set of images using the OIA software emulating a simplified digital
microscope is another important advantage of the present metho-
dology.

The described procedure was successfully applied to a case study of
characterizing the evolution of pore space properties of carbonate rocks
exposed to SC CO2.
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Annexes

Annex 1. Instructions for image acquisition by SilverFast SE Plus 8I

1st order 2nd order 3th order

Open SilverFast
Start: Silverfast
Select information Type (positive)

Prescan
Preview “preliminary scan and selection of area for detailed scan”
Settings Menu > Exposure Settings “Gain + 1 for polarized images and Gain 0 for non polarized images” Save settings
Settings Menu > Set Focus “Autofocus”
Settings Window “configuration as Hi-Res and 24-Bit Color”
Scann “aprox. 2 min per image”

File > Save Image (.tif, uncompressed)
Exit

Annex 2. Instructions for spatial correction of images by QGIS 2,14,0-Essen

1st order 2nd order 3th order

Open QGIS
Open New Project
Raster > Georeferencer > Georeferencer “to open the plugin”.

Open Raster “Image 1 and + proj = longlat + datum = WGS84″
Add Point “Enter coordinates from information of the same image x-y pixels”
Start georeferencing “Polinomyal 1, closest neighbor”
Save Image “1 geo-ref, .tif”
“Open next image”
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Open raster “Images 2 to 4 + proj = longlat + datum = WGS84″
Add Point “Enter coordinates from previous Image geo-referenced”
Start georeferencing
Save Image “2 to 4 geo-ref, .tif ”

Close Georeferencer
Raster > Extraction > Clipper
“Selection of areas of interest”

File > Save Images
Close Clipper
Save Project
Exit

Annex 3. Instructions for image segmentation and measurement by ImageJ 1.50i.

1st order 2nd order 3th order

Open ImageJ
File > Open > .tif
“to open georeferenced image from image set”.
Image > Adjust > Color Threshold > “window threshold is displayed”

Thresholding method > Default “selection of method”
Threshold color > Red “selection will be shown red”
Color space > RGB “system used for segmentation”
Select segmentation ranges in histograms>
If image is in cross polarized light then
R: [0–60]; G [0–55]; [0–65]
If image is in plane polarized light then
R [185–255]; G [190–255]; [160–255]
Select > “partial binary image is generated”

Process > Binary > Make Binary
File > Save as > .tif “to save partial binary image”.

Go to File Open until open all images
“all images of image set”
Process > Image Calculator >
“window image calculator is displayed”

Binary1 and Binary2 and Binary3 and Binary4
“They are intercepted –and operator- to generate final binary image”
File > Save as > .tif “to save final binary image”.

Analyze > Set Measurements >
“window set measurement is displayed”

Parameters: A, P, D, Axis.
Ro, As

Analyze > Analyze Particles >
“window analyze particles is displayed “

File > Save Results and Summary “.xls format”
Exit

Annex 4. Instructions for image visualization by virtual microscope in ImageJ 1.50i.

1st order 2nd order 3th order

Open ImageJ
File > Open > .tif
“to open georeferenced images from image set”.
Image > Type > Stacks > Images to Stack > “Stack of images”
Image > File > Save as > Image Sequence “Sequence in .tif”

Import pluging: Action bar
Image > File > Save as > Image Sequence “Sequence in .AVI″
Exit

6. Annex 5

https://drive.google.com/open?id=1uIUjW8uwEXfwwPM-5D-UiNL9H2sEA1sO.
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